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Excel: The Basics 
 
To enter data/information in an Excel Worksheet, simply click on a space (known as a cell) and enter content 
on the worksheet. To move to the next cell hit TAB (to go to the right) or RETURN/ENTER or the down arrow 
(to go down). With Excel, you can enter in the following types of content: 

• Numbers 
• Currency 
• Date 
• Time 
• Percentages 
• Fractions 
• Text 
• Customized Information 

 

 
 
A Worksheet 
In Excel, the page that you are looking at with all of the cells is a single Worksheet. The file that you are saving 
is a workbook. A workbook can contain one or more worksheets. You will see at the bottom of the screen that 
when you create/open a new Excel file, there are usually three worksheets created. You can add/delete 
worksheets as necessary.  
 

 
 
 
 
 

Each square in this worksheet is a cell. 
Each cell is associated with a letter and a 
number. This cell is B2 because it is 
located in Column B, Row 2.   

Click here to instantly add a new 
worksheet. 

Double-click a sheet name (i.e., Sheet 1) 
to change to a new name.  Right-click on 
a sheet to insert, delete, move or copy 

sheets. 
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Format a Cell 
If you right-click on any cell and select Format Cells you can see the different types of formats available to you, 
and the ways in which you can choose to display that format.  For example, If you right-click on a cell – choose 
Format Cells – and then select the Date Option on the left (beneath Category), you will see the different types 
of ways that the date can be displayed. See below. 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 

There are many different date formats available to 
you. Select the one that you prefer and hit OK at the 
bottom. Now when you enter in a date in that cell, it 

will be listed in that format. You may also select 
multiple cells and adjust the format of multiple cells at 

one time.  Oftentimes this is done when you want a 
column or row to all be formatted similarly.   
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Formatting Multiple Cells 
In the screen below, I selected the entire time column (by right-clicking on the letter B at the top of the column 
and selecting Format Cells) and am formatting all cells in that column to a specific time format.  
 

 
 
 
Once you select the specific time format that you would like. Click OK. You should see your current times listed 
in Column B change to the new format.  
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Entering Text & Expanding Column Size 
In Excel you are not just limited to numbers. You can enter text where necessary. Oftentimes, you will need to 
expand the column width to include all entered text. There are two ways to expand a column, automatically 
and manually.  As you can see below, I entered in text and because there was more text than space in the cell I 
cannot read everything that was entered. 
 

  
 
To Manually Expand the Column: Bring your cursor up to the top of the column (in this example, to the line 
indicating the right-side of Column D). Click on the right line (between Column D and E) and manually drag that 
line to the right until the column is at a desired width. Now all text should fit comfortably within the cell.  
 
To Automatically Expand the Column: Bring your cursor up to the top of the column to the line on the right-
side of the column. In this example, bring your cursor to the line between Column D and E.  Double-click on 
that line and the column will expand to exactly the right width that would include your longest text string. See 
below.  

 
  

As you can see here, when you enter in text (or 
any content for that matter) if it does not fit in 

the current cell space it will “spill over” into 
other cells (that do not have content) or it will 

be hidden underneath cells that do have 
content. You need to expand the column 
manually or automatically to view all text. 

Click on this line at the top of the 
worksheet, on the right-side of 

the cell that you want to expand.  
Single click and drag to expand 

manually or double-click to 
expand automatically. 
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Entering & Formatting Currency 
When you enter in currency, you have the option to: 

• Display a symbol ($) next to each dollar amount 
• Adjust the number of decimal places (choose 0 if you want to round to whole numbers) 
• And adjust how negative numbers are displayed (see choices below) 

As always, select the cell(s) that you would like to format, right-click on your mouse, and choose Format Cells. 
Select the Currency option from the Category choices and then select the desired options. Click OK when 
finished. See below for more details.  

 
 

These are the numbers that I want to 
format. I want to add a $ symbol, I want 
two decimal places to be displayed, and I 

want negative numbers to have a – symbol 
in front of them.  I selected the entire 

column by right-clicking on the “F” cell at 
the top of the column and selecting Format 

Cells. I then selected the Currency option 
on the left-hand side and adjusted my 

settings as you see below. 

This is where you adjust your options for 
how the currency will be displayed 

depending on your preferences. 



 
 

Page | 6 
 

Basic Formulas 
Excel can do all the calculations for you. In the current example I have a list of purchased items and the 
number of each item that was purchased. I now want to calculate the total price for each component. For 
example, I purchased two external hard drives at $89.99 each. What is the total cost for both? Luckily, Excel 
can do the calculations for you IF you enter in the formula to compute that value.  In this case you want to use 
a Multiplication Formula to multiply the # of items (items in Column E) by the price for each item (amounts 
listed in Column F).  
 
To enter in a formula, click the cell in which you want to enter the formula. In this case it is Cell G4. Then click 
on the Insert Function button on the Formula Bar. See below. Excel will insert an = sign for you, which is the 
beginning of the formula that you will choose.  
 

 
 
 
 

This is Cell G4 

This white space is the Formula Bar 

This is the function button. 
Click here to search for 
and/or select a function 

Search for a function or 
select the function that 

you would like, and then 
hit OK. If you highlight a 
function in the list it will 

explain what it does 
beneath that list. 
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Select the function that you want to use. If you don’t know what function you want to use you can type in a 
question that describes what you want to do in the Search for a function box (for example, “multiply numbers” 
returns the PRODUCT function), or you can browse from the categories in the Or Select a category box.  
 
Enter the arguments (cell numbers that you want to use).  In this example the Product function multiples two 
or more numbers together. You must select the cells which contain the numbers that you want to multiply. 
 
First, click on the Expand Dialogue button to select the cell that you want to use as your first number.  See 
below. 
  

 
 

This is the Expand 
Dialogue button. Click 
to manually select the 

cell that contains 
Number 1. Or you can 
manually enter in the 

cell information. 
Repeat for all other 
numbers. Below you 

will see the total listed 
and the description of 
the function. Hit OK 

when done.  
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Then click on the cell that you want to use as your first number. Then click on the Close Dialogue button. You 
will now see the cell number that you selected listed for Number 1. You can also manually enter in the cell 
number in that space as well.  Repeat for Number 2 (and number 3, 4, 5, … if applicable). Click OK. You will 
now see the final product. In this example, the final product is listed in cell G4. It contains the product of Cell 
E4 multiplied by Cell F4.   =PRODUCT(E4, F4).  
 

 
 
 
 
 
 

 
 

Here I clicked on Cell E4. You can see 
that when I clicked on it, it was 

highlighted with a dotted line AND it 
entered in the cell information in the 
Function Argument Space below. You 
can now click on the Close Dialogue 

button. 

This is the Close Dialogue 
button. Click on this 
when you are done 

selecting the Function 
Argument. 

You now have selected both Function 
Arguments and this window also lets 
you see what the final result will be (in 
this case $179.98. Click OK to insert this 
function into your Excel worksheet. 
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Now in the worksheet you can see the Total appear in Cell G4. Also, if you click on that cell, you can see the 
function used in the Formula Bar. See below. 
 

 
 
Enter a Formula Manually 
If you know the exact formula that you want to enter, you do not need use the Insert Function feature. You 
can simply click on the cell, then manually enter in the function, in this case =PRODUCT(E4, F4)  Then hit 
RETURN/ENTER and the result will be displayed in that cell.  
 
Common Formulas 

• =AVERAGE(number1,number2,number3,…..) 
• =MEDIAN(number1,number2,number3,…..) 
• =MODE(number1,number2,number3,…..) 
• =SUM(number1,number2,number3,…..) or =SUM(firstNumberInColumn:lastNumberInColumn) 
• =QUOTIENT(numerator, denominator) – returns the integer portion of the devision 

 
Also, if you select cells and then click on the AutoSum button, you can choose from popular formulas such as 
Sum, Average, Count Numbers, Min, Max, etc.   
 

 

You can view and edit the formula here 
in the Formula Bar.  

Here you see the result of the formula 
displayed 
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Copying & Pasting Formulas 
Lastly, as you know, we want to repeat this formula for all rows in this column. Essentially, we want to multiply 
the contents in Column E by the contents in Column F for Rows 5 – 10.  Rather than have to enter each formula 
manually and select cells manually, we can simply copy Cell G4 and paste that content into Cells G5 – G10. This 
is because we are not copying the Value ($179.98) we are copying the Formula (=PRODUCT(Num1, Num2)). 
Excel will automatically take the product of the two cells to the right of Column G.   
 
Select Cell G4. Then copy that cell by hitting CTRL-C or clicking on the Copy Button in the top left-hand corner.  
Then select all the cells in Column G beneath cell G4 that you want to paste the function into. To paste, hit 
CTRL-V or Select Paste from the menu bar in the top left-hand corner.  
 
 

 
 
 
Now you have all of the totals for each item listed based on the number of items purchased for that item. 
 
 
 
 
 
  

Select all the cells that you want to paste content 
into (in this case, all the cells that are in the red 
box). Hit the Paste button in the top right-hand 

corner or CTRL-V to paste the formula. You will see 
that the product of the formula is now displayed in 

each cell. Now you may want to format this 
column to display the numbers with a $ symbol 

and two decimal places (depending on your 
preferences). Do you remember how to do that?  
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Challenge Activity: The Sum Formula 
Now, can you figure out how to display the Final Total (as shown below)?  This final total is the SUM of all 
amounts listed in Column G.  Are you going to enter in the function manually? Or use the Insert Function button 
to find and use the appropriate function?  If you don’t know what function to use, what would you enter in the 
search bar to find that function?  There are many ways to insert a function!! GOOD LUCK!! 
 

 
 
Consider this Useful Formula: Combine First and Last Name 

 
 
 

How can you get this total to display 
through the use of a Formula in excel??  
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Creating a Basic Chart using the Chart Wizard 
In Excel, you have the option of displaying your content as a chart. The following charts are available to you: 

• Column 
• Line 
• Pie 
• Bar 
• Area 
• Scatter 
• Other Charts: Stock, Surface, Doughnut, Bubble, and Radar 

 
First, select the content in your worksheet (by highlighting it) that you would like to turn into a chart. In this 
example, we will select all elements in the total option to create a Pie Graph of the totals. So I will select Cells 
D4 – D10 because that has the name of the items, and then I will also select Cells G4 – Cells G10.  Since these 
cells are not all next to each other, I use the CTRL button to copy both cells. First I highlight Cells D 4- D10, then 
press CTRL and highlight Cells G4 - G10 
 
Then, I want to select the appropriate chart for my data. I click on the Insert tab, and then select Pie.  You will 
see that when you choose Pie, you have 2D and 3D options. Choose the Pie graph that best suits your needs 
and continue.  
 

 
 

 
 
 

Here are your chart choices.  
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Moving Your Chart 
Once you select the appropriate graph, it will now display on that worksheet. You can move the graph to 
another location on that worksheet by clicking on the border and dragging it to a desired location. You can also 
move the graph to its own worksheet (this will display a larger graph).  To move a chart to its own worksheet, 
right-click on the chart and select Move Chart.  Then select New Sheet and pick a new sheet to add it to.   
 
Customizing Your Chart 
Once your chart is created you may want to customize it. This may include (but is not limited to): 

• Adding a title, legend, or data labels 
• Changing the colors 
• Adding percentage values or numbers 

 
When you click on the chart you will see that you have a variety of Chart Tools at your disposal. You can edit 
the design, layout, and format.  
 

 
 
 
 
 
 
 
 
 
 

 
 
  
 

Here you can switch between Design, 
Layout, and Formatting Options for your 
Chart 

Here you can choose a Chart Layout that 
suits your needs. These layouts will add 
titles, data labels, a legend, and /or 
percentages/values depending on the 
option that you choose. Test out the 
different options before settling on one. 
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You can further customize your Chart options by clicking on the Layout tab in the Chart Tools area.  
 

 
 
Here you can select options such as Chart Title and decide whether you want a Chart Title and/or 
where it should be located on the Chart.  You can turn Data Labels off or on, and/or decide the 
location of the Legend. Experiment with these options until you find one that suits your needs.  
 
Another way to format your Chart is to right-click on the chart area and select Format Chart Area.  
Additional options will be available. 
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Changing the Chart Colors 
If you would like to change the colors of the chart, simply click on the section of the chart that you 
wish to change (in this example – one of the pie pieces). You will notice that the Format tab is now 
selected in the Chart Tools area. Now you can click on Shape Fill and select the color of your choice.  
 
 

 
 

New Colors & A Chart Title Added Below 

 
 
Changing the Chart Type 
If you want to change the Chart Type, right-click on the chart and select Change Chart Type. 
 
Copy Chart into Word Document 
Copying a chart into a Word document is quite easy. Simply click on the chart (so that it is selected), 
click on the Copy button in the top-left corner (or press CTRL-C). Then, open up your word document 
and bring your cursor to the space in the Word document where you want to insert the chart. Select 
Paste (in the top-left corner of Word) or press CTRL-V. 
 

 
 


